W-8x8x Getting Started

(Version 1.3)

Hardware & Software & Application
Using I-7000/1-8000 Series Modules

Warranty

All products manufactured by ICPDAS Inc. are warranted against defective
materials for a period of one year from the date of delivery to the original purchaser.
Warning

ICPDAS Inc. assumes no liability for damages consequent to the use of this
product. ICPDAS Inc. reserves the right to change this manual at any time without
notice. The information furnished by ICPDAS Inc. is believed to be accurate and

reliable. However, no responsibility is assumed by ICPDAS Inc. for its use, or for any

infringements of patents or other rights of third parties resulting from its use.
Copyright

Copyright 1997-2010 by ICPDAS Inc., LTD. All rights reserved worldwide.
Trademark

The names used for identification only maybe registered trademarks of their
respective companies.
License

The user can use, modify and backup this software on a single machine. The

user may not reproduce, transfer or distribute this software, or any copy, in whole or in

part.
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1 Introduction and hardware setup

Welcome to the W-8x8x user’s Quick Start manual. ICPDAS provides this manual

for new user how to install the hardware and software quick start.

1.1 Introduction

The main hardware of the W-8x8x embedded controller are depicted in figure 1.1,
which include VGA, USB, compact flash, series, Ethernet and an 1/O slot standard
interface . ICPDAS also provides another remote 1/0O modules. You can communicate
the remote 1/O modules by pass through the COM3 (RS-485 network). On the
standard Ethernet port, you can use the intranet and internet advantages such as

www , ftp, SQL database application and so on.
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For The software develop, ICPDAS provides two DLL files, namely the
WinconSDK_DLL and the Wincon_DLL, for the I-8000 series modules which are used
in the W-8x8x Embedded Controller. The WinconSDK_DLL has all the essential DLL
functions designed for the 1-8000 series modules for Microsoft WinCE.Net platform. It
can be applied on embedded Visual C++, and even on the newer platforms. Users
can easily develop WInCE.NET applications on W-8x8x by using this toolkit. The
various functions in WinconSDK_DLL are divided into the following sub-group
functions for easy use in different applications. For more detail please refer to the
WinconSDK.lib for embedded Visual C++

Fig. 1-2
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1.2 Hardware Setup( for W-8X8X)

There is the W-8781 hardware setup sample (Fig. 1-3). In the right side
connect the standard computer interface like 15 pin VGA port monitor (can
support the touch screen as HMI device),USB, and Ethernet. In the middle and
left area, you can plug in the ICPDAS’s I-8K series I/0 modules. The W-87XX
can plug in 7(max.) local /0 modules and W-8381 for 3(max.) local I/O modules.
On the under lift side, The COM2 is a standard 5 wire RS232 com port. You can
connect the standard RS232 device (modem ...). The COM3 is standard RS485
port. You can connect to the RS485 devices like ICPDAS’s products I-7K series

I/O modules and I-87KX expansion unit.

Windows CE

. 7 1/0 Slots
CPU:PXA 270, 520MHz USB :

Ezprog-| software I 1

Power
10~30VDC
LED
Indicator y
107100M Base-T VGA Analog Input/Output
Compact Flash Digital Input/Output
Motion/Timer/Counter
Fig. 1-3

By the Ethernet ,you can communicate to the Ethernet devices such as
[-7188EX(palm size Embedded Controller), SQL Server , mail Server, MMS Server,
iPush Server and so on. (Fig. 1-4)
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If the devices connect was completed, please connect the DC 10V~30V input to
the under right side and frame ground to the earth ground finally(if you have earth
ground). Please attention that Wincon’s power consumption is low(typical 0.15A at
24VDC) , But On the Power On moment (in 200ms), the Wincon need more current to
start up (typical 1.2A at 24VDC).

W-8x8x Getting Start Manual -6



1.3 Specifications

Main Control unit

xScale PXA-270 CPU, 520MHz ®m 1 VGA port :320x240x16 to

SDRAM : 128M bytes 1024x768x16 Defaultis 800x600x16
Flash  :32M bytes m 1 Compact Flash slot : CF memory card
FRAM : 128K bytes B Reset button(reboot after holding on 3

64-bit hardware unique secs)

serial number m  Power LEDs

Built-in Watchdog Timer m  Multiple Booting Selection :
Real Time Clock

W-8X8X

USB 1.1 Host x 2
1 x RJ45, 10/100BaseT

Cabinet

COMO: Internal use
COM1: Reserved
COM2: 9-pin D-Sub (RS-232)
COMa3: 2-wire Terminal Block (RS-485)
FRnet(option)
I/O Expansion Slot :
3 - slot for W-8381
7 - slot for W-8781

Power Supply : 20W, Unregulated + 10Vdc +30Vdc

Environment :

Operating Temp. : -25°C to + 75°C ( Depends on I/O modules)
Storage Temp. : -30°C to +85C

Humidity : 5~95%

Dimensions :
230.25x110x93.8 (3 slot)
354.26x110x93.8(7 slot)

I/O module(optional)
I-8000 series modules, which include DI,DO,AQ,AI...
I-7000 series modules, which include DI,DO,AQ,AI...

For more information please refer to relative catalog or http://www.icpdas.com
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1.4 System Recover

1.4.1 System Recover form CF card

To prevent the disappear of data in Flash in W8x8x for accident or incorrect
operation(exp: the unstable power ) from operating not properly ,the W8x8x has the
function of System Recover .User can recover the Flash’s data that include the
WiInCE’s Kernel and the WInCE’s Registry before entering the OS of WInCE by
System Recover.

Because the System Recover of W8x8x is in the Bootloader stage ,it's needless to
enter the WIinCE’s OS or to operate by Keyboard and Mouse. The System Recover is
writing the file W8x8xBackup.bak at the root path of CF card back to the flash in
W8x8x. The thing has to attention the file’s name isn’t include date and time ,and the
file must be made by Wincon Utility’s back up system in W8x8x. Besides the name’s
date and time of the file, it will maybe lead the W8x8x to operate not properly if the
User modified the content of the file that is for recover.

| [——Con_figure i3k
»0: RUN

The steps of recover:
Step 1: Power off the W-8x8x
Step 2: Put the CF card in W-8x8x that has W8x8x_Backup.bak, and something have
to attention:
- the file’s name must be “W8x8x_Backup.bak”
- W8x8x_Backup.bak must be at the root of CF card
-> W8x8x_Backup.bak is made by WinCon Utility’s backup function and
user didn’t change it’s content, only have to move the date and time
in file’s name.
Step 3: Turn the Rotary Switch to "9”
Step 4: Hold on the Reset Button on the panel of W8x8x,and power on until the led
stop blinking.
Step 5: To Observe the led until it has been snuffed out ,after rebooting the system
should be recovered.
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1.4.2 Recover Registry

The registry is the major system setting in WinCE, it's permitted that user restore the

registry to the factory settings, if the user set error or forgot some settings(exp:IP,) to

cause the system abnormal . The steps as follow:

Step 1: Power off the W-8x8x

Step 2: Turn the Rotary Switch to "B”

Step 3: Hold on the Reset Button on the panel of W8x8x,and power on until the led
stop blinking.

Step 4: To Observe the led until it has been snuffed out ,after rebooting the system
should be recovered.

1.4.3 The Selections of Boot

The W-8x8x can be boot by:

1. the CE kernel in Flash

2. the CE Kernel image(NK.bin) in CF card

3. the CE Kernel image(NK.bin) in USB drive
If user want to boot with CF card in the W8x8x or USB disk ,it's necessary to put the
CE kernel image file “NK.bin” on the root path of CF card or USB disk.

Boot with the Kernel Image in Flash :

Step 1: Power off the W-8x8x

Step 2: Turn the Rotary Switch to "0”

Step 3: Power on and waiting for the boot finish .

Boot with the Kernel Image(NK.bin) in CF card:

Step 1: Power off the W-8x8x

Step 2: Turn the Rotary Switch to "2”

Step 3: Power on and waiting for the boot finish (about 45 sec).

Boot with the Kernel Image(NK.bin) in USB disk:

Step 1: Power off the W-8x8x

Step 2: Turn the Rotary Switch to "4”

Step 3: Power on and waiting for the boot finish (about 120 sec).

W-8x8x Getting Start Manual -9



1.5 Dimensions

3 slots :

Top View

|

[

Right Side View

7 slots :

-

-l an

Right Side View

(&

ﬂ’m}m

23

10853

751 9L6 140

% oo (| /o
= | o
oo () oo
5 ’lt == . |
N ,f‘\ =T = llgm
Q O Bl |
—
|
Front View
o g oo §ocrrm gy f b §ocp f oD ||| e || arn
S E EHE E B E B2 e
eS|l o e e n e e e || & | &=
oy ey Bu_ v B v R D RC pRCoDEC D C Ty | Cp
e jloown o e n D g esn e e || &= | &
cwer e By e p R pRCc bR pRCblcp o B
ool (el el Bl el Bl Il e | e I | )
wmo |l e lcolco e | o | || e || =
Top Vlew
Unit; mm
P . P v
2 P\ [
IR ] || ] | ) ] | ] |
=N Kl Bl Bl Bl Bl Bl W e )
0 dollch e e e e e | aen || e | =
£ SI=ZIS|=|E|IS|ISIS(=(=S
3 S EIEIEISIEISEIEE
a 5 S EIEIE BB B Elmg
A

Front View

W-8x8x Getting Start Manual

1
Bottom View




1.6 What’s News

Added 1.3 Specifications

Added 1.4 System recover

Added 1.5 Dimensions

Added 2.2.2 Touch Panel driver in General setting

Added 2.2.6 Enable one of communication modules in W8x8x in New Card
Wizard

1.7 Package List

® One set of W-8x8x hardware
® One Compact Flash card for storing system files.
® One software utility CD
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2. W-8x8x System Settings

In this section, we will explore how to set the Windows CE System and the
“WinCon Utility” for the W-8x8x embedded controller. You can change configurations,

such as the system time or network setting of the W-8x8x through the Windows CE

control panel. WinCon Utility allows you to view W-8x8x’s information or save the

current system configuration into Windows CE OS image.

2.1 Windows CE Settings

Setting Up the System Time

You can setup a new date or time in the Windows CE system by using the

following steps:

1. Choose Start - Settings - Control panel to open the Control panel dialog.

File View
»

Password

T

Regional
Settings

Accessibiity  Certificates  DENETRINE

B 29

Remove
Programs

|7 [ %
A 5 P = H @ &
x5 9P = e
Display  Input Panel  Internet Keyboard Mouse  Metwork and  Owher
Options Cial-up Co...
L ¥ Jo
Storage System Wollrne &
Manager Sounds
Fig. 2-1

2. Double click the Date/Time icon on the Control panel dialog.

DatefTime Properties

CX E3

Date/Time |
ORI | CrentIme
[M1335am =
S MTWTF S —
20 30 1 3 4 5 | Tinszone
6 7 8 8 1011 12 : _
13 14 15 16 17 16 1o | 1(@MT+08:00) Taipei ~]
20 21 22 23 24 25 26 | [ ] AUtomatically sclst clock for caviant sayina
57 28 20 30 31 1 - |
4 5 b  Apply

Fig. 2-2

3. When the Date/Time Properties dialog displays, set the date or current Time
and click the Apply button to set your system date and time.
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=  Note: If you have changed any value of the date and time. You must save
the registry by means of WinCon Ultility tools. For more information about
WinCon Utility tools, please refer to the WinCon Ultility section.

Setup the network

Generally, most users don't need to setup the network because DHCP is the
default setting. However, if your network system does not contain a DHCP server, you
need to configure the network setting by using the manual method. The following
steps demonstrate the procedure for how to configure the network system.

1. Choose Start > Settings - Network and Dial-up Connections on the

Windows CE desktop to open this dialog.

2. Double click the ETH11 icon to open the “DM9000/9000A/9010 ISA Fast
Ethernet Adapter Settings” dialog.

'DMOD00/9000A/9010 ISA Fast Ethernet Adapter’ Settings  [U4
IP Address | Mame Servers

An IP address can be (O Obtain an IP address via DHCP
autormatically assigned to this

computer, If your network @ :’ér:leciﬁf an IP address:
does not automatically assign

IP addresses, ask your netwaork IF Address: | 0.0 .0 33 |

administrator for an address, cubnat Mask: [255.255.255. 0 |

and then type it in the space =

provided, Default Gateway: | |
Fig. 2-3

3. When the “DM9000/9000A/9010 ISA Fast Ethernet Adapter Settings” dialog
displays (see figure), click (enable) the “Specify an IP address” radio button
in the IP Address tab and type in the IP Address, Subnet Mask, and Default
Gateway into the respective fields.

4. Choose the “Name Servers” tab and also type in the Primary DNS,
Secondary DNS, Primary WINS, and Secondary WINS into the respective
fields, as shown in the figure below.
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IP &ddress | Mame Servers

Marne server addresses may be  Primary DMS: |1E|B. 05,1 .1
autornatically assigned if DHCP

You can specify additiohal : .
WINS or DMS resclvers in the Filiialy ERSs |

space provided. Secondary WINS: |

|
is enabled on this adapter. Secondary DNS: | - ' ' |
|
|

Fig. 2-4
5. Click OK.

= Note: If you have changed any value of network configuration, you must
save the registry by means of WinCon Utility tools. For more information
about the WinCon Utility tool, please refer to the WinCon Utility section.

Setting up the Device Name

You can configure W-8x8x to have the device name of your choice. To change

the device name please refer to the following steps:

1. Choose Start - Settings - Control panel to open the Control panel dialog.

2. Double click the System icon on the Control panel dialog to open the System
Properties.

3. When the System Properties dialog is displayed (see figure), select the
Device Name tab in the dialog window.

These settings are used to identify your Windows CE device to
o », other computers,
aed Please type a name (without any spaces) and a short description,

Deyice pame:

Device destription: [WindowsCE Device

Fig. 2-5
4. Type your preferred Device Name in the Device Name box, and click OK.
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= Note: If you have changed any information of the Device Name, you must
save the registry by means of WinCon Utility tools. For more information
about the WinCon Utility tool, please refer to the WinCon Utility section.

Here, we only provide some demonstrations for configuring your settings. The
configuration steps and operation methods are the same as with the windows system.
However, you need to keep in mind “if you have changed any setting on W-8x8x
embedded controller, you would need to use the WinCon utility to save the
current setting into non-volatile internal memory”. Otherwise, when you restart

the system, the setting will not change.
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2.2 WinCon Utility

The WinCon Utility provides many tools to save/view the system information
registry and to setup the HTTP/FTP path and update non-volatile internal memory
within the W-8x8x embedded controller. This handy utility (WinCon Utility 1.exe
located in the Compact Flash/ICPDAS/Tools directory) should be located in the
computer's Program group. Therefore, you can launch it on the computer through
Start - Programs -> WinCon Utility menu. The WinCon Utility provides many
functions within the following five tabs:

® System Configuration Tab
General Setting Tab
Auto-execute Tab
Version Update Tab
Server Setting Tab
New Card Wizard Tab

CONFIGURATION

Fig. 2-6
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2.2.1 System Configuration Tab

Click the location of white ball will enter System Configuration Tab. The System

Configuration tab allows you to view the information in the Wincon-8000 embedded

controller system.

Wincon Utility Ver 1.0 - Reboot UnMNecessary

Modules
Slot 1:
Slot 2 ¢
Slot 3¢
Slot 4 :
Slot 5 :
Slot 6 ¢

Slot 7 :

System Configuration

—
—
—
—
—

Other Data

Serial Murnber
Mac Address
Flash Mermory Size .

25 Wersion @

Wincon SOK Wersion

|E|1 B8 7131 11 00 00 10

|?6:2F:?2:51:6D:2D

|32M bytes

|Wir'|CE 5.0 ICPDAS 2008/02/22

|WinCDn SDK 3.0

Ay setting changed could be pre-viewed,

View Reqgistry

S Home

Fig. 2-7

The System Configuration tab includes the following folders:

® View Registry button: Any settings are changed in the WinCon embedded

controller can be pre-viewed by using this function. It is just like the regedit

function in the windows system that you are very familiar with (shown in

below figure).

File Help

(] HKEY_CLASSES_ROOT
-] HKEY _CURRENT _USER
#- ] HKEY _LOCAL_MACHINE

#- (1 HKEY_IUSERS

MName l Data

Fig. 2-8
® Slot 1~7 box: The Slotl~7 fields display the module names plugged in the

W-8x8X.
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Serial Number box: This field displays the serial number of the W-8x8x.
MAC address: The field displays the physical address of Ethernet port.
Flash Memory Size box: This field displays the Flash memory size of the
W-8x8x.

OS Version box: This field displays the current operating system.

WinCon SDK Version box: This field displays the current WinconSDK.DLL

version.

2.2.2 General Setting Tab

It is very important to save the registry when you change any system
information. Then you need to click the “Confirm Registry” button to renew the
system configuration. If you do not save the current configuration into the registry, you

will lose your information settings when you reboot the Wincon-8x8x.

Wincon Utility Ver 1.0 - Reboot Mecessary

Gereral Setting | Update Wersion | Auto-execution | Server Setting | Mesw Card Wizard
Set Touch Panel Memory regulation
i1 R5232 Move slider to the left for more mermory to run
programs.Move slider to the right for more storage
~ room, Only unused RAM can be adjusted.
<3 USB
L =
BDD | Starage oo g s « Program
Resotution—— | [19 || ey | — — | Ve
| | | | [|jFregency alocated  9408KE Slocated  23300KE
800 ¥ 600 pixels |E'U Hz A InUse  1288K In Use E852K
BackupfRestore All DumpjfRestore Registry —
Backup Registry ,05 and the other settings to a file. The default path is as To durnp or Restore only
follow for Reqistry.
|\CDmpactFIash\WElelx_Backup.bak | | Backup All | | Dump Registry |
Click the button to restore all of settings from the selected file. | Restore All | | Restore Registry |
ActiveX Language
To Register the Register Regional  and Change Recover to Confirm
EzHMI's ActiveX ActiveX Language Settings J Factory Settings Settings
\@4” Y ICP DAS CO., LTD. -
e = = Confirm Registry g Home
SO A PR A A ) = :
e

Fig. 2-9
The General Setting tab includes the following folders:

® Change the VGA resolution box: You can setting the VGA Resolution to
320x240,640x480,800x600 or 1024x768, and 2,4,8,16 bits color (Bpp),the

W-8x8x Getting Start Manual --18



monitor reflash Frequency for normal TFT LCD setting is 60 Hz.

Interface type of Touch Panel: If You want to use W-8x8x with touch panel, You
have to select which interface the touch panel has. And now, the driver of
supposed touch panel only for APLEX.

Memory regulation: You can move the slider to the left for more memory to run
programs or move the slider to the right for more storage room. Only unused
RAM can be adjusted.

Backup/Restore All: This function provides to backup Registry ~ OS ,and the
other settings to a file. You can set the file’s path on the path edit. User can also
restore all of settings from a file by Restore All button.

Dump/Restore Registry: To dump and restore only for registry.

ActiveX: If the user will use the EzProg-1 ,you can register the ActiveX object by
the button.

Recover to Factory Setting button: It will take several seconds to clear your
registry settings back to Factory Setting and Wright to non-volatile internal
memory.

Language : You can change regional and interface language setting here.

OK
Regional Settings | User Interface Language l Input Language ]
-Your locale

The locale option affects how some programs format nurmbers, currency,
tire and dates.

|Er'|gli5h (United States) - Customize. ..
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2.2.3 Auto-execute Tab

The Auto-execute tab, provides ten execute files, which can be run after the
WiInCE system has been launched on the W-8x8x system. You can set ten execute
files through the Browse button on the tab for WinCon Utility, as shown in the below

figure. Note that they are executed in order of program 1, program 2, ...

| General Satting | Update version | Auto-esercution | Server Setting

Program 1: |\CDmpactFIash\EzPng—I\EzGo\EzGD.exe |
o Program 2: | |
oo
A Program 3: | |
ICPDAS Program <: | |
Program 5: | |
At most 10 programs can Program &: | |
be specified to execute
autornatically when Pragram 7: | |
system starup, And there
is hone dependency .
hetween each program. FUE I 5t | |
Select the location which Prograrn S: | |
youl weattt and push down
the browse. Prograrm 10: | |
|Cunﬁrm Settingl | Browse |
\@A” * ICP DAS CO., LTD. : ;
= % - Confirm Reqgistry S Home
WS s R R A RS .
S I

Fig. 2-10

The tab includes the following folders:
® Program 1~10 boxes: These files allow one to configure the auto-execute
files for W-8x8x for when it is started up. You can choose the execute file and
file directory path by means of the Browse button.
® Confirm Setting button: If you have changed the settings for the Program 1
~ 10 field contents, you must then click the Confirm Setting button before

closing the WinCon Utility window.
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2.2.4 Version Update Tab

The Version Update tab provides the function to be able to update newer
versions of the operating system. Users can download the OS image file from the web

site: http://www.icpdas.com. You can choose the new OS image file nhame and

directory path with the Browse button. Click the “Write to flash now” button to update
the current OS version. It will take ten or more minutes to update your OS to Flash
memory, and then reboot your system. Before Update OS Version, back up the

registry if You hope to have the same settings.

Wincon Utility ver 2.0 - Reboot Necessary

wersion Update | auto-execute | Server Setting
Specify the new OS image file for version update.
| | Browse I
write to Flash Now
@& . ICP DAS CO., LTD. | - -
- = = = Confirm Registry Home
WA Bas A AR A PR 5] -
ot :

Fig. 2-11
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2.2.5 Server Setting Tab

This tab provides functions to set the password for Telnet/FTP service and to setup
the HTTP/FTP directory path.

wincon Utility Ver 1.0 - Reboot Necessary

General Setting | Update Wersion | &uto-execution | Sefver Setting | Mew Card Wizard

Password for Telnet/FTP Service

[] FTP Server Password ! | ‘

[ Telnet Server Confirm Passwiord | | ‘

“hange FTP default directory \Temp', to :

|| YTemph, ‘

Chahge HTTP default directory YWCornpactFlash Termp\HT TPY to

|| YoompactFlash TermpyHTTRY ‘

Confirm
Settings

‘s Home ‘

_\::Y__ lcp DAS co-, LTD- B confrm —
NS B R A R 8]

Fig. 2-12

® Default FTP/Telnet account: root
® Password for Telnet/FTP Service: You can set password protection for FTP or

Telnet server here.
® Change FTP default directory to box: Enter a FTP default directory path and

click confirm settings button to setup the defined path to the ftp server.
® Change HTTP default directory to box: Enter a HTTP default directory path
and click on the confirm settings button to setup the defined path for the web

server.
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2.2.6 New Card Wizard Tab

This page shows not only which module in W-8x8x but also which communication
module registered. The primary purpose of this tab is to register the communication
module that user want to use. But W-8x8x only support one communication module
now. If user put on more than one communication module, the registry button will be
disable.

wincon Utility Ver 1.0 - Reboot Necessary

IGeneraI Setting lUpdate Wersion ] Auto-execution ] Server Setting | New Card Wizard

Module Name———— Resource
Slotd I
Slot2 . |

h:‘ 1/ Base:BOOO340

Slot3 I I-8112
Slotd I I-8057

e SYSINTR:2C

E‘""'" T o B!

Sts I q;‘ /O Base:BO00360
Slota | ,ﬂ;ﬁ S¥SINTR:2d
Slot7 | ] |! Slot_4: 1-8057
Registry
Change To Information

New Module

—

\@¥  ICP DAS CO., LTD. , :
= D:E &ﬁﬂﬁﬂﬁﬁ};ﬁ- F&.‘ﬂ“ S] B Confirm Registry S Home

Fig. 2-13

® Module Name : User can see all kinds of modules on W-8x8x.

® Resource :User can see what the communication module in use is, and what the
com port number is.

® Registry : If the W-8x8x only has one communication module, this button will be
enable. And this button will help user to register communication module.

® [nformation : If the W-8x8x has more than one communication module, here will
appear the alarm message.
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3. Architecture under WinCE.NET

The WinconSDK.DLL is the dynamic link library (DLL) files that are designed for
applications running on the W-8x8x main controller unit and its modules with Windows
CE.NET. The user can apply them to develop their own applications with many
development tools, such as embedded Visual C++. In order to assist you, there are
many demo programs provided for the user when using EVC++. Based on the demo
programs, users can easily understand how to use the functions and develop their

own applications within a short period of time.

The relationships among the WinconSDK.DLL and user’s application are

depicted as follows:

Fig. 3-1
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Functions for the W-8x8x Main Controller Unit;

ok~ wbd

6.

Get Module ID functions;

Analog Input/Output functions;

Digital Input/Output functions;

Motion card application functions;

Encoder card application functions;

Support for eMbedded Visual C** Language;

The DLL functions in Wincon_SDK.DLL are designed for WinCE.NET and can be
utilized by eVC++. The main characteristics of the Wincon_SDK.DLL that have been
developed the application in the eVC++ developer environments, are very simple to
use just like the applications in ActiveX(OCX) controls. Users can easily find the
method they need for their application from the descriptions in the following section
and in the demo programs developed by ICP DAS.
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4. Installation W-8x8x SDK for EVC on PC

“W-8x8x SDK for EVC ” consists of the following major items.
® \WinCon SDK DLL & library files for EVC
® WinCon SDK include files for EVC

Step-by-Step Installations of WinconSDK

1. Please insert the CD-ROM into your CD-ROM driver.

N

Then run “W8X8XGM1_YYYYMMDD.msi” in the folder of CD-ROM: \SDK\.

w

After successfully the software will be installed:

B WinCon SDK library & DLL files are located at C:\Program
Files\Windows CE Tools\wce500\W8x8x GM1\Lib\ARMV4

B WinCon SDK include files for EVC are located at C:\Program

Files\Windows CE Tools\wce500\W8x8xGM1\Include\Armv4
4. W8x8xGML1 is the hardware platform name for W-8X8X .

|:| WExdx_8017 - Microsoft eMbedded Yisual C++ - [ZDGraph.cpp]

Bl File Edit ‘iew Insert Project Buld Tools Window Help

S = B EﬂﬂDraw}( j "
|C2DGraph vlngII class memhers]j| § Drawx ~| @ -~ ||
‘WoxBx_801 ¢|W8xBxGM1  +)|Win32 [WCE ARMV4I) Debug LﬂWExBxGM1 Dt:vit:e)

2l

5 Workspace "W8x8x\8017": 1 project(s)
-2 Wax8x_8017 files
-3 Source Files
2DGraph.cpp
buttonst.cpp

font.cpp
GRAPH.cpp
StdAf<.cpp
Wix8x_8017.cpp

nt eFont,=o0ldFont;

//create the font of errod
eFont.CreateFont (25, 12, 8, A
/
FALSE, FALSE, B, ANSI_CHAR!
[£] WoxBx_8017.rc OUT_DEFAULT_PRECIS,
Wix8x_8017Dlg.cpp CLIP_DEFAULT_PRECIS,
-3 Header Files DEFAULT QUALITY,
5 2DGraph.n  WCE platform Configuration  perauLT_PITCH|FF_SWISs, _T.

buttonst.h

—
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5. Start The First Application Program

5.1 Applications in eMbedded Visual C™ (MFC)

When users want to create a new program, they have to use these files from the
EVC™ environment toolkit, as shown in the following:

1. \WINCON\AINC\WinconSDK.h = include all .h files

2. \WINCON\INC\WinCon.h -> functions for D/I, D/O

3. \WINCON\INC\i8017h.h - functions for 1-8017H Module
4. \WINCON\INC\i8024.h —> functions for 1-8024 Module
5. \WINCON\INC\i8092.h —> functions for [-8092 Module
6. \WINCON\INC\i8094.h - functions for 1-8094 Module
7.

\WINCONI\LIB\WinconSDK:.lib = import library of WinconSDK.DLL

The application procedures for how to create a program are listed below. More
detailed information for each step will be described in the following section.

Create a Forms-Based Application,;
Specify the Locations for Demo Files;
Configure Compiler Options;
Configure Link Options

Design an application program;

Build the application program,;

Execute the application program on the W-8x8x platform;

© N o g A~ WD PRE

Example list for the reference of user program design.

5.1.1 Create a Forms-Based Application

A form is the dialog box with control items that lets users access and possibly
change data. You may want to develop an application in which the user chooses from
a selection of forms. Commonly, a forms-based application allows the user to choose
“‘New“ on the “File” menu to access forms. A dialog-based application, which does

provide menus, is also considered a forms-based application.

Users can apply the WCE MFC AppWizard (exe) to create a forms-based
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application. When creating a new form, they have the choice to create a single

document interface or a dialog-based application.

A single document interface (SDI), forms-based application allows only one
instance of a particular form to run at a time. However, it is possible to run
different forms at the same time from an SDI, forms-based application by

selecting a new form from the “New” command in the File menu.

A dialog-based application is a form based application by definition. However,
if you choose this option, you will not be able to use the “New Form”
command on the Insert menu to add additional forms to the application. A
dialog-based application does not use the document/view architecture. So,
when you need to add forms, you have to manage the creation and access
methods for them.

The last step of the wizard lets you view and change settings for the classes

created by the wizard. For a single or multiple document interface application, you

should set “CformView” as the base class for the view class of your application. If your

application is database supported, you can also select any class that is derived from

“CformView”. A form is any window derived from “CformView” or from any class that

comes from “CformView”.

To create a demo for forms-based application

1.

Firstly, users need to open the EVC™ software. Then, in the “File” please
click the “New” to open a new program.

In the “Projects” tab, select “WCE MFC AppWizard (exe)” and set the
Project name: “Demo” and the “Location” ,then select the location that you
want . Then, select “Win 32[WCE ARMV4I]“ in the CPUs list box and other
options if necessary. Finally click “OK” to start the wizard process, as shown
in the following figure.
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MNew @

Files Projects | Workspaces

"®|WCE Application Project name:

£ WCE ATL COM AppWizard Test

|%) WCE Dynamic-Link Library

fi=WCE MFC ActiveX ControlWizard A

%&WCE MFC AppWizard (dIl) Logation:

RAWCE MFC AppWizard (exe) IE:‘EVC PROGRAM(Test _-J

%] WCE Static Library

@+ Create new workspace

" Add to current workspace
[T Dependency of:
CPUs:

WWin32 (WCE ARMVA

VIWin32 (WCE ARMVAI)
[IWin32 (WCE ARMVAT)
[Win32 [WCE MIPS16)
[Win32 [WCE MIPSII)

[Win32 [WCE MIPSII_FP) -

OK I Cancel I

Fig. 5-1-1
3. The configuration of WCE MFC AppWizard.
(3a) WCE MFC AppWizard: Step 1 of 4: Set “Dialog based” as shown in the

following figure. Click “Next” to go to the following step.

WCE MFC AppWizaxd fexe) - Step 1 of 4 ; _'?_| _x_]

Application What type of application would you like to
create?

(~ Single document

¥ Document/View architecture support?

What language would you like your resources

in?
|

< Back | Next > | Finish Cancel

Fig. 5-1-2
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(3b) WCE MFC AppWizard-Step 2 of 4: Please enter a title for your dialog in
the defined area and click “Next” to go to the following step (see figure
5-1-3).

WCE MFC AppWizand {exe) - Step 2 of 4

2]

What features would you like to include?

I~ Windows Help
I~ ActiveX Controls

Please enter a title for your dialog:

Demo

Help contents file: IDemn.ht;.

< Back | Next > | Finish | Cancel |
Fig. 5-1-3
(3c) WCE MFC AppWizard-Step 3 of 4: In this step, please choose “Yes,

please” to generate source file comments. And set the MFC library as

a shared DLL or statically linked library. Then Click “Next” to go to the
next step.

WCE MFC AppWizard {exe) - Step 3 of 4

21|

File Edit Yiew Insert Build Help

" No, thank you

How would you like to use the MFC library?

' As a shared DLL
" As a statically linked library

< Back | Next > | Finish Cancel

Fig. 5-1-4
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(3d) WCE MFC AppWizard-Step 4 of 4: Click the “Finish” button to start the

AppWizard to create the classes, which are shown in the figure below.

(see figure 5-1-5).

WCE MFC AppWizard (exe) - Step 4 of 4 2| %]

AppWizard creates the following classes for
ou:

CDemoDlg

Class name: Header file:
ICDemnApp lDanmApp.h

Base class: Implementation file:
|C\'Vim‘i.pp ]Demm‘-.pp,r.pp

< Back I Next> | Finish I Cancel

Fig. 5-1-5

5.1.2 Specify Locations for Demo Files

The Directories settings in Options for eMbedded Visual C™* specify search

paths for files in your projects. These include lists of paths for the following types of

files:

File type

Path contents

Executable files

Specify locations for the build utilities, such as the compilers
(CL, CLARM, CLMIPS, and so on), NMAKE, LINK, and
BSCMAKE.

Include files Specifies where the compiler should look for “include” files (for
example #include <stdio.h>).

Library files Specify where the linker should look for libraries to resolve
external references.

Source files Specify where the debugger should look for default source files,

such as the Microsoft Foundation Class Library and the
Microsoft run-time library.
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Path information is stored in directory settings and it allows you to configure them.
You can change both the paths listed in these settings and the order in which

eMbedded Visual C*™" searches for them.

The path specifications have separated the setting for the different devices and
the different platforms (such as WCE emulator) supported by your installation of
eMbedded Visual C*".

To specify default folders for demo project files

1. Open the “Options” dialog in the “Tools” menu.

2. Inthe “Directories” tab, select the “W8x8xGM1”(for W-8X8X) on the
“‘Platform” item, “Win32 [WCE ARMVA4I]” in the “CPUs” item and also
the “Show directories® in the “include files” or “Library files” item.

3. Since all the WinCon specific include and library files have been
allocated in default directories, users don’t need to modify the contents of
default directories of include and library files .

4. Fig 5-1-6 display the default location of include files.

Options @@
Tabs | Debug | Compatibility | Download | Build Directories | W EE
Platform: CPUs: Show directories
\wexexGM1  ~ | e e ~|[include fites  +]
Directories: R E

C:\Program FilesiWindows

C:AProgram Files\Windows CF Toolsiwceb00\W8x8xGM1\atllinclude

Location of WinCon SDK Include files

OK Cancel

Fig. 5-1-6
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5. Fig 5-1-7 displays the default location of Library files.

r‘Options @
Tabs | Debug | Compatibility | Download I Build Directories I W E]z
Platform: CPUs: Show directories
|W8x8xGM1  ~||Win32 (WCE ARMV4I) Rd|[Library files -

:Directories‘ X"‘ 4
‘- C:\Program Files Wmdows CE Tools wce!il]l] WBxBxGMI liblARMY4I

C:\Program
C Ii.Proqram Flles\Wmdows (E Toolsiwce5001W8x8xGM1\atlilib\ARMY4I

Location of WinCon SDK Library files

0K Cancel

Fig. 5-1-7

= Note: If you want to remove a folder, select it and then press DELETE.

5.1.3 Configure Compiler Options

To set the compiler options in the development environment, please follow these

steps:
1. Inthe “Project” menu, choose “Settings” to open the “Project Setting”

dialog.
2. Select the configuration “Win32 [WCE ARMV4I] Release” in “Settings

for” item as shown in following figure.
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pr

Project Settings

Settings For:
lWin32 [(WCE ARMVAI] Release j

All Configurations
Multiple Configurations...

Win32 (WCE x86) Debug

Win32 (WCE x86] Release

-2/
General l Debug | CiC++ | Link | Resources | M?

ieset

Microsoft Foundation Classes:
Use MFC in a Shared DLL ~|

~ Output directories -

Intermediate files:
|ARMV4IReI

Output files:
|ARMV4IFleI

[~ Allow per-configuration dependencies

OK Cancel

Fig. 5-1-8

3. Inthe Project Settings dialog, select the “Link“ tab and set the library file

name as “WinconSDK.lib” in “Object/library modules” item.

-

.

Project Settings

Settings For:
|Win32 [WCE ARMV4I) Release v/

BNz Test]

(7=
General | Debug | C{C++ Link | Resources | M:

Category: |General | Reset |

Output file name:
IARMVdIReIﬂ'est.exe

Objectflibrary modules:

inconSDK.lib

[~ Generate debug info [~ Ignore all default libraries

I~ Generate mapfile

Project Options:

WinconSDK.lib fnologo /base:"'0x00010000" &
{stack:0x10000,0x1000 fentry:"wWinMainCRTStartup" | |
fincremental:no /pdb:"ARMVA4IRel{Test.pdb"

v

OK Cancel

-

Fig. 5-1-9
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5.1.4 Configure link options

After finishing program, You have to download the execute file to W-8x8x by CF
card ,FTP ,etc....Now, You have another choice by online download. You only have to
link the PC with W-8x8x by telnet, after linking the execute file will exit at the path “\My
Device\” in W-8x8x. You must do something for the link.

STEP 1: select Configure Platform Manager in Tools
| |50L_test - Microscft eMbedded Visual C++ - [SQL_testDlg.cpp]

Flle Edit iew Insert Project Build |Tools Window Help

S == i
|CSQL_testDIlg || (AN class

Saurce Browser, ., Alk+F12

Y Error Lookup
|5(1|-_tl‘-5t j|W3X3XGM1 A Remote Call Profiler (WCESOD)

. 2% Remate File Viewer (WCESO0)
Workspace 'SQL_test': 1 proj /4 Remote Heap Walker (WCESOD)
= SQL_test files A% Remote Kernel Tracker (WCES00)

-3 Source Files A% Remate Performance Monitar (WCESDO)

SQAL_test.cpp /‘,‘ Remate Process viewer (WCESOD)
50L_testrc A Remate Registry Editor (WCESOD)
g&:?;'?j;g'g-cpp A% Remote Spy-++ (WCESD)
i A Remate Systerm Information (wCESDO)

+-[_] Header Files
. Remote Zoomin (WCESOO
+-_7 Resource Files 74 Remotz Zoomin | )

ReadMe.txt Sglect Remote Tools »

Cuskamize. ..

Options...

i : Macra...
Record Quick Macra Ckrl+5Shift+R.
Play Quick Macro Zhrl+5hift+P

Configure Platform Manager... Flg ] 5_ 1_ 10
STEP 2: select the W-8x8xGM1 Device and Click the Properties button

Windaws CE PlatForm Manager Configuration

gelect a platform or device to configure

(- G amsac70 4dd Device
@ sh_IA

=@ STANDARDSDK Delete
o-@@ WexExGM1 :

| TL#y WoExGML Devies Eopsries S

@@ WINCON_Ma About
@ Windows CE Default Platform

Fig. 5-1-11
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e =)

Device Properties

Dievice Mame:
W3xE=GM1 Device

Select a trangport and a startap server. Choose Test to verify that wou can
eztablish a connection to wour farget device with the selected transport and
startup server

Confignre. .
Startup Berver:
Manmal Server ﬂ Confignre ...

oK Cancel | Test |

Fig. 5-1-12
Push down the Configure button of Transport appears follow page. You can choose
Fixed port and enter the Port number to avoid the command line different every time.

TCPRJIP Transport Configuration @

Configuration For device:
hafBEGM Device

[ iheck connechion siaiis Interval (msecl [E00nn
¥ Fized port Port number; W
Haost [P
* |ze fixed address: |'IEI.EI.EI.3EI j

" Configure automatically aver serial

1] Cancel

Fig. 5-1-12-1
STEP 3:select TCP/IP Transport for Windows CE in Transport selections
Tramsport:
| TCPAF Transport for Windows CE |
EITL Transport for Windows CE
Microsoft Actived

TCPRAP Transport for Win C Fig. 5-1-13
STEP 4:select Manual Server in Startup Server selections

Startop Server:
|Ma.nusl Berver ﬂ
CESH Server for Widows CE

Mannal Server

Microsoft Actived e | Fig_ 5-1-14
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STEP 5:select GO in Start Debug of Build or push down the button “F5”

|:| S0L_test - Microsaft eMbedded Visual C++ - [SOL_testDlg.cpp]

[ File Edit Yiew Insert Project |Build Tools Window Help
= &
|CSQL_testDIg

2 Compile SOL_testDlg.cpp  Chrl+F7
Build S0OL_test, exe F7

AN € g i

Batch Build. ..

Clean

ISOL_test | /WBxBxGM1

Skart Debug
Update Remote Cukput Filels)

YWorkspace 'SQL_test': 1
--E8 SQL_test files
--£3 Source Fileg
SOL_test.cpp
SOL test.rc

Execute SOL_test exe Ckrl+FS

Set Active Configuration. ..

E
BES
1q j|WBxBxGM1 Device

p : implementation fil

5 PR

1 step Into F11
MY Runto Cursar ChHFID

Aktach bo WiCE Process., .,

HEW

SQL_testDlg.cp Configurations. ..
stdAfx.cpp Set Active PlatForm...
+-[771 Header Files — -
Fig. 5-1-15

STEP 6:remember the command line but don’t push down “OK” button until

step8 finish

"
Manual Server - Action

==

Pleaze make zure the following files are oh the device

WM DO S tepipe. dil
WM D DWW Shoemgre. exe
TN D OWS Seetlstub.dll

CEMEEC FXE wi . .
CEMGRC.EXE /5 /T:TCRIPC.DLL /3 /D:10.0.0.30:2233

Cancel

Fig. 5-1-16
SETP 7:select “Run”in start menu of W-8x8x

.@ Brograms
'{,‘g Favarites
D Docurmerts

[F Settings
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STEP 8:key in the command line on the open path and push down “OK?” button
then back to step6 push down the “OK” button

:E Type the name of a program, folder, or
: docurnent, and Windows wil open it for you,

Cipen; I.E}{E JS  Titopipe.dl jQ JD:10.0.0,30:2888

0K Cancel Browse...

Fig. 5-1-18

Finish about 8 steps, You also finish download the execute file to W-8x8x. But You
have to pay attention to two things. First, if You didn’t move the downloaded file to CF
card it will disappear. Another is that if Your project is debug mode the execute file
can not run after You move it to CF card and reboot. Only the execute file built on
release mode can run after reboot.
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5.1.5 Design an Application Program

After you finish the initial creation of a project, you can build user interfaces.
These interfaces can involve the first design and creation of dialog boxes, menus,
toolbars, accelerators, and other visual and interactive elements. Then you can
hook them up to code. Due to the difference in size and shapes of devices, the user
interface elements must be tailored to the design requirements of each targeted
device. In the following we will explore some methods on how to create control items

in the user’s program.

To create an Edit Box:

1. Inthe “Workspace“window, select the “ResourceView“tab. Click on the
“Dialog” folder to expand it and double-click the “IDD_DEMO_DIALOG" in
order to open the dialog form as shown in below figure.

DDemo-MicrosoFt eMbedded VYisual C++ - [Demo.rc - IDD_DEMO_DIALOG [German {Germany)] (Dialog)] = | =4 @
File Edit Yiew Insert Project Build Layout Tools Window Help e 5[ lt_l
8 =zEd y B | <2 v O o B %]Drawx LJ "
ICDemoDIg L”[AII class members]L][ § CDemoDlg _vJ 2 QAIlEME e BT 0 &
Demo v||W8x8xGM1  ~|/Win32 (WCE ARMVAI) Debug  ~||W8x8xGM1 Device || | Y
_Iﬁ ||I|.|I|-|-Ix-|-1-.-.I...|Ix...I|...I||||I||||I|.|.I-|-|l|- i('j
=<3 Demo resources * — = — | &
--£3 Dialog _ [|—Pemo =] Au abl
@UQD DEMO_DIALOG [G| = =)
+-(]lcon 2
+- (] Version - ®
:
o ZU ERLED.: Dialogfeld-Steuerelem.
2 hier = Em E
I H I £ m
= - [
: = 3
: & B
- ¢
< I > 2
- = 3 »
" Class... Iﬁl Reso... I E] FileVi... l = = s
¥ : : (1ol F | B | BT
Ready 0,0 i 288 x 144
Fig. 5-1-19

2. By clicking the icon ﬂ to create a static text object.
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3. Right-click on the Static text object and select “Properties”.
4. When the Text Properties dialog is shown, set “Input DO Value” in the
“Caption” field.

Text Properties B Al
44 %  General | Styles | Extended Styles |

ID: [IDC_STATIC ~| Caption: nutDO Value

v Visible v Group
[~ Disabled [~ Tab stop

Fig. 5-1-20

5. Click the icon ﬂ to create an edit box object.

6. Right-click on the edit box object and select “Class Wizard”.
7. When the MFC Class-Wizard dialog is shown, select the “Member

Variables” tab.
MFC ClassWizard 21 x|

Message Maps Member Variables l Automation I ActiveX Events | Class Info |

Project: Class name: Add Class... v I

IS - |  [cDcmoDig =l
Add Variable... I

CiprojeciDemoiDemoDlg.h, C'\proiecﬂDemo\DemoDlg cpp

Control IDs: Member Delete Variable |

IDC_EDIT1
IDCANCEL Update Columns |

IDOK
Bind All |

Description:

0K I Cancel

Fig. 5-1-21
8. Click the “Add Variable” button to add a new member variable.
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Add Member Variable i _"J 5]

Member variable name:

{m_DO
Cancel
Category:

Emivoll

Variable type:

[CEdit =

Description:

map to CEdit member

Fig. 5-1-22
9. Set“m_DO”in the “Member variable name* field, and configure the
“Category:“ dropdown-box as “Control”, and “Variable type:“ as “CEdit”.
10. Once you have completed the above list of steps, click the “OK* button to
save the Member variable and close the dialog.

To create a Button:

1. Create a new button object by clicking on the icon ﬂ in the “Con..” window.

2. Right-click on the Button object and select “Properties”.
3. When the Push Button Properties dialog is shown, type “Digital Output”
into the Caption field (see figure), and close the dialog.

Push Button Properties - 2l
44 % General I Styles l Extended Styles l
ID: [IDC_BUTTONT ~| Ccaption: g put
v Visible I Group
[~ Disabled v Tab stop
Fig. 5-1-23

4. Double-click on the Push Button object so that you can edit the button’s event
code. Then type “OnBtnDO” into the “Member function name:” field (see
figure 5-1-15), and click the OK button to display the Editor window.

W-8x8x Getting Start Manual - 42



Add Member Fonction .ﬂl‘.‘

Member function name: 0K
Cancel

Message: BN_CLICKED
Object ID: IDC_BUTTONI1

Fig. 5-1-24
5. In the Editor window, type the code in as follows:

void CDemoDlg::0OnBtnDO()

{
// TODD: Add your control notification handler code here
int DOVal;
int slot=1;
TCHAR temp[48];

m_DO.GetWindowText(temp,10);
DOVal=_ttoi(temp);
DO_8(slot, DOUal);

Fig. 5-1-25
6. Press CTRL+Home to move your cursor to the top, and then insert the
“#include “WinconSDK.h” ” within the header area.

// DemoDlg.cpp : implementation file
/7

#tinclude *“stdafx.h"
#tinclude *“'Demo.h"
#include “DemoDlg.h"

#tinclude “WinconSDK.h" /

#ifdef _DEBUG

#idefine new DEBUG_NEW

#undef THIS_FILE

static char THIS_FILE[] = __FILE_ ;

Fig. 5-1-26
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5.1.6 Build the Application Program

Microsoft eMbedded Visual C++ provides two ways for building an application
program. The first and most common method is to build the application program within
the eMbedded Visual C*™* development environment. The second method is to build
the application program by using command-line tools within the MS-DOS prompt
environment. The procedure for building an application involves a number of items
namely the preprocessor, the compiler, and the linker. Their main functions are
described as below:

e The preprocessor prepares source files for the compiler by translating macros,

operators, and directives.

e The compiler creates an object file containing machine code, linker directives,

sections, external references, and function/data names.

e The linker combines the code from the object files created by the compiler

and from the statically-linked libraries, plus it resolves the name references,

and also creates an executable file.

The Building Process

The following diagram shows the components in the building process using
eMbedded Visual C++ and starting with the editor in which you create your source
code.

l—{ Editar I—l
¥

| Saurce I | Makefile I | Header Filas I
| Pr

hello.cpp ioztrearm.h

*
eprocessar I-ﬂ—
*

| Campiler I

+
[ object Fil= | hello. obj

¥
Object Files I—>| Linker I<—| Libraries I

rmlibcewqg.lib

| Debug VYersion I |Re|ease "Jersinnl

hello,exe hello,exe

Fig. 5-1-27
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If you build your program outside the IDE, you may use a makefile to invoke the
command-line tools. Microsoft eMbedded Visual C** provides the NMAKE utility for
processing makefiles. If you build your program within the IDE, the eMbedded Visual
C++ project system will use the project (.vcp) file to store the make information.

The .vcp file is not compatible with NMAKE. However, if your program uses a makefile
rather than a .vcp file, you can still build it in the development environment as an
external project.

To Build the Demo Application

1. On the “Build“ menu, choose “Build Demo”.

2. If you have finished the above steps, you would obtain the following message
in the Output window, which means the execution application has been built.
Otherwise, you will get error messages. You would then need to debug the
source code and rebuild the application.

DemoDlg.cpp
Generating Code...
Linking...

Demo.exe - @ error(s), 0 warning(s)

Fig. 5-1-28
3. If there no error messages are produced, you will find the Demo.exe file in
C:\Project\Demo\ARMV4Rel\.
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5.1.7 Execute the Application Program on the W-8x8x Platform

When you have finished the building process for the Demo.exe, you could apply
the developed execute file (Demo.exe) into the W-8x8x controller unit. For example,
you can use a portable memory stick (Like Pen Driver) to store the file and to copy it to
W-8x8x. In a following section, we will develop a method for how to download the
application to the main controller unit through the Ethernet (TCP/IP) or RS-232 series
protocol. The main idea for running the user program within the W-8x8x target control

device is to make the process simple just like in the following steps.

1. Copy the Demo.exe from C:\Project\Demo\ARMV4Rel\ subfolder to the
W-8x8X.

2. Double-click on the Demo.exe file to run it on the W-8x8x, as shown in
following figure.

Demo m

TODO; Place dialog controls here.

Input DO Yalue |3

Digtal Output |

Fig. 5-1-29
3. Type “3”into the “Input DO Value” field (above figure), and click the “Digital
Output” button. Then, you can turn on the channel 0 and 1 of the Digital
output Module plugged into the slot 1 of W-8x8x.
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5.1.8 Online debug

When You want to debug online, push down “F9” or Click & at any location that You

want to debug. Then a red point will appear at that location, it means this program will

stop there.
'CE ARMV4I) Debug  ~|[WB8x8xGM1 Device -l & @ A
szTree[i] = strBuf; et 5 i (79)]
wsprintf{Trunk[i],_T("Slot_%d: I-%s"),i,szTree[i]); nsertjRemave Breakpaint (79)
swprintf(textBuf[i],_T("I - %s"),strBuf);
= ¥
= SetDlgltenText(nSlot[i], textBuf[i]};
ff========check how many com_port cards========
moduleID = GetHameOfHodule{i, charBuf);
[ ] | iF(muduleID==11l|| |moduleID=="144| |[moduleID==112| | noduleID==142})
Hum++;
b
b if(Hum>=2)
kel ¢
= SetDlgltemText(IDC_Static_Information, _T{"W-8x8x ONLY support one communicat:
o m_Register.EnableWindow(false);
b
= else
& {
SetDlgItemText(IDL‘_Static_InFurmatiun, L e )
m_Register.EnableWindow{true);
¥
KN

Besides, if You have many variables want to check, You can add these variables in

Watch table.
ﬂhﬂl‘l‘lﬂ alue
m_TabH.GetCuriel() CiXB@17: Error: symhol “m_TabN" not found
rc Cxs8017: Error: symbol "rc' not Found
tenAutoRunEntry 018024328 struct AUTO_RUM_ENTRY =
tenfAutoRunEntry
dim(tenﬂutuﬂunEntry} CiXBA17: Error: symhol “dim" not found
File CXX8817: Error: symbol “File™ not found
textBuf 8x18124fbB unsigned short (* textBuf)[8]
szTree Bx18125830 class CString = szTree
s1lotID 8x18124e58 unsigned long = S1otID
Slot 8:188219ch int = Slot
5lot_Tree Cxs8017: Ervor: symbol "Slot_Tree" not found
c5lot CX80617: Error: symbol "cSlot"™ not found
s1lotID 8x18124e58 unsigned long = S1otID
S1otID[i] CXX8817: Error: symbol “i* not found
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